
Installing and Upgrading Server Applications

This chapter explains how to install the SecurityManager server software and other server applications, namely
CiscoWorks Common Services.

• Understanding the Required Server User Accounts , on page 1
• Using Remote Desktop Connection or VNC To Install Server Applications , on page 2
• Installing Security Manager Server and Common Services, on page 3
• Accessing Cisco Security Manager using Third-Party Certificate, on page 5
• Upgrading Server Applications , on page 6
• Migrating Security Manager to a New Computer or Operating System, on page 29
• Updating Security Manager , on page 30
• Obtaining Service Packs and Point Patches , on page 31
• Uninstalling Server Applications , on page 32
• Downgrading Server Applications , on page 32

Understanding the Required Server User Accounts
CiscoWorks Common Services and Security Manager use a multilevel security system that allows access to
certain features only to users who have the required authorization. For this reason, there are three predefined
user accounts that are created on any system on which you install an application that runs on top of Common
Services:

• admin — The admin user account is equivalent to a Windows administrator and provides access to all
Common Services, Security Manager, and other application tasks. You must enter the password during
installation. You can use this account to initially log in to the server and to create other user accounts for
normal day-to-day use of the applications.

• casuser — The casuser user account is equivalent to a Windows administrator and provides access to
all Common Services and Security Manager tasks. You do not normally use this account directly. Do
not modify casuser (the default service account) or directory permissions that are established during the
installation of the product. Doing so can lead to problems with your being able to do the following:

• Logging in to the web server

• Logging in to the client

• Performing successful backups of all databases
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The following five permissions are assigned and set, automatically, at the time of Security Manager
installation:

• Access this computer from network - casusers

• Deny access to this computer from network - casuser

• Deny logon locally - casuser

• Log on as batch job - casuser, casusers

• Log on as a service – casuser

• System Identity—The system identity user account is equivalent to aWindows administrator and provides
access to all Common Services and Security Manager tasks. This account does not have a fixed name;
you can create the account using whatever name fits your needs. If you create the account in Common
Services, you must assign it system administrator privileges; if you use Cisco Secure Access Control
Server (ACS) for user authentication, you must assign it all privileges.

If you install Cisco SecurityManagement suite applications on separate servers (the recommended approach),
you must create the same system identity user account on all servers within the multi-server setup.
Communication among your servers relies on a trust model that uses certificates and shared secrets. The
system identity user is considered the trustworthy account by other servers in the multi-server setup and
therefore facilitates communication between servers that are part of a domain.

You can create as many additional user accounts as needed. Each user should have a unique account. To create
these additional accounts, youmust have system administrator authority (for example, using the admin account).
When you create a user account, you must assign it a role, and this role defines what the user can do in the
applications, even to the extent of what the user can see. For more information on the various types of available
permissions, and how to use ACS for controlling access to the applications, see Managing User Accounts.

Beginning with Cisco Security Manager 4.21, Cisco Identity Services Engine (ISE) can be used for
authentication purposes, in the place of earlier ACS server.

Note

Using Remote Desktop Connection or VNC To Install Server
Applications

We recommend that you install server applications when you are logged directly in to the server.

However, if you must perform a remote installation (logging in through another workstation), consider the
following tips:

• Do not attempt to install the software from a remote disk. The software installer must reside on a directly
connected disk drive. The installation might appear to succeed from a remote disk, but it does not actually
succeed.

• You can use Virtual Network Computing (VNC) to install the software.

• You can use Remote Desktop Connection to install the software. If you use Remote Desktop Connection,
Cisco recommends using a Remote Desktop Protocol console session and not a non-console session.
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Installing Security Manager Server and Common Services
The main Security Manager installation program can install the following applications:

• CiscoWorks Common Services 4.2.2—This is the foundation software that is required by the server
applications. Beginning with Security Manager 4.4, the CiscoWorks Common Services check box no
longer appears on the component selection page; installation of Common Services is selected by default.

Beginning with version 4.26, Azul JRE 1.8.0 Update 322 will be installed for fresh installation.Note

• Cisco Security Manager 4.28—This is the main server software for Security Manager.

When you install the Security Manager, the Cisco Common Works Common Services 4.2.2 and Cisco
Security Manager Client 4.28 gets installed by default as a part of CSM 4.28 bundle.

Extract the zip file and rename the folder. While renaming, make sure the name
of the folder does not contain spaces or any special characters except "_".

Note

Use the following procedure to install or re-install these applications. If you are upgrading from a previous
version of any of these applications, before proceeding, see Upgrading Server Applications , on page 6.

Before You Begin

• Refer to the Licensing for Security Manager chapter of this installation guide

• If you are installing the product as an upgrade to an existing version of the application that is already
installed on the server, run a backup as described in Backing Up the Database for Remote Upgrades ,
on page 25. Ensure that the backup completes successfully, and that your existing applications are
functioning normally before installing an upgrade.

• When installing a permanent license for Security Manager, you must stage the license file on a disk that
is local to your Security Manager server. The license file must be on the server to select it during
installation, because Security Manager does not see mapped drives if you use it to browse directories on
your server. (Windows imposes this limitation, which serves to improve Security Manager performance
and security.) Do not place the file in any folder in which you will install the product.

The path to the license file must not contain special characters such as the ampersand (&).Note

• Ensure that you go through the Readiness Checklist for Installation.

• Ensure that the server meets the requirements listed in Server Requirements and Recommendations.

• We recommend that you install Security Manager on a dedicated server in a controlled environment.
Installing other software applications can interfere with the normal operation of Security Manager and
is not supported.
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• Do not change the system time after installing Common Services. Such changes might affect the working
of some time-dependent features.

• If you want to use Cisco Secure Access Control Server (ACS) to provide AAA services for user access
to Security Manager , wait until you install the applications before you configure Common Services to
use ACS. For information on configuring ACS control, see Integrating Security Manager with Cisco
Secure ACS.

If you install SecurityManager after configuring Common Services to use ACS, you are told during installation
that the application that you are installing requires new tasks to be registered with ACS. Select Yes if you
have not already registered the application (on this or another server) with ACS. If you have already registered
the application, if you select Yes, you lose any customized user roles configured in ACS for the application,
so you should select No. All Security Manager servers that use the same ACS server share user roles.

Procedure

To install Security Manager Server, Common Services, or more than one of these applications using the main
Security Manager installation program, follow these steps:

Step 1 Obtain or locate the installation program. Log in to your Cisco.com account and go to the Security Manager home page
at http://www.cisco.com/go/csmanager. Click Download Software and download the compressed installation file for
Security Manager.

• Using your choice of file compression utilities, such as WinZip or the Compressed (zipped) Folders Extraction
Wizard, which is provided with operating systems supported by Security Manager 4.28, extract all the files in the
compressed software installation file to a temporary directory. Use a directory that does not have an excessively
long path name; for instance, “C:\CSM” is a better choice than
“C:\Cisco_Security_Manager\server\installation_directory.” Start the installation program, Setup.exe, which normally
unzips to the same directory as the compressed file.

If an error message states that the file contents cannot be unpacked, we recommend that you empty the Temp
directory, scan for viruses, delete the C:\Program Files (x86)\Common Files\InstallShield directory, then
reboot and retry.

Tip

Step 2 Follow the installation wizard instructions. During fresh installation, you are asked for the following information:

Backup location—If some version of Common Services or SecurityManager is already installed, the installation program
allows you to perform a database backup during the installation. If you elect to perform the backup, select the location
to use for the backup. However, it is typically better practice to perform a backup before starting the installation.

The location that you select to use for the backup must be outside NMSROOT . The location NMSROOT is
the path to the Security Manager installation directory. The default is C:\Program Files (x86)\CSCOpx. In
particular, note that NMSROOT \backup must not be used for the backup.

Note

Destination folder—The folder in which youwant to install the application. Accept the default unless you have a compelling
reason to install it elsewhere. If you specify a folder other than the default folder, make sure that it does not contain any
files and that it has fewer than 256 characters in its pathname. Also, if you specify a folder other than the default folder,
the path must not contain any special characters.

Make sure that the installation directory path on a non-system drive does not contain the special characters-”(“
and “)”. Installation will not proceed if these special characters are present.

Note

• Applications—The applications you want to install—Security Manager. CiscoWorks Common Services 4.2.2 is
installed automatically when you install Security Manager.
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• License information—Select one of the following:

• License File Location—Enter the full pathname of the license file or click Browse to find it. You can specify
the permanent license file if you have previously staged it on the server.

The path to the license file must not contain special characters such as the ampersand (&).Note

• Evaluation Only—Enables the free 90-day evaluation period.

• Admin password—The password for the admin user account, at least 5 characters. For more information on this
and the system identity and casuser accounts, see Understanding the Required Server User Accounts , on page 1.

• System Identity user—The username and password for the account you want to use as the system identity user.
When installing Cisco Security Management Suite applications on multiple servers, use the same system identity
user account on all servers.

• Create casuser—Whether to create the casuser account on new installations. You must create this user account.

If you have security policies on password complexity restrictions, this account creation may not succeed.
In such cases, you need to manually create the casuser account (see further instructions for the casuser
password in Table A-3, Table 1).

Note

Step 3 After the installation is complete, restart the server if it does not restart automatically.

Ensure that the source installation directory does not have any special characters. If there are special characters
in it, Security Manager will throw a warning message and the installer will exit.

Note

Accessing Cisco Security Manager using Third-Party Certificate
You can install third-party certificate to access the CSM server. To invoke the CSM server in secure mode,
you can:

• Configure the hostname in your server certificate properly and use the same hostname to invoke CSM.

• Use a server certificate issued by a prominent third-party certificate authority.

• Do the following browser changes if you are using Self-Signed certificates:

• In Mozilla Firefox 2.0, select Accept the Server Certificate forever (until it expires) in the New Site
Certificate wizard, if you are confident about the identity of the server.

• InMozilla Firefox 3.0, select Permanently store this exception in the Add Security Exception dialog
box, if you are confident about the identity of the server.

• In Internet Explorer, install the certificate in the browser's trusted certificate stores, if you are
confident about the identity of the server.

• To install the certificate in Internet Explorer 6.0, see Certificate installation in Internet Explorer 6.0:

• To install the certificate in Internet Explorer 7.0:, see Certificate installation in Internet Explorer 7.0:
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Certificate installation in Internet Explorer 6.0:

Step 1 Invoke CSM in secure mode.
Step 2 Click the View Certificate button in the security alert window that appears.

The Certificate dialog box appears.

Step 3 Click Install Certificate... in the Certificate dialog box.

Certificate installation in Internet Explorer 7.0:

Step 1 Select Tools > Internet Options.
Step 2 Click the Content tab.
Step 3 Click Certificates.

The Certificate dialog box appears.

Step 4 Click Import... in the Certificate dialog box.

The Certificate Import wizard appears which guides you to import the certificates.

Upgrading Server Applications
Application upgrade refers to the process of installing a newer version of an application while preserving the
data from the older version. There are three types of upgrade paths:

• Local—You simply install the newer version on the same server that is running the old version without
first uninstalling the old version. Your existing data is maintained and available in the newly installed
version. Keep the following in mind when doing local upgrades:

• Before you use this method, ensure that all applications that you are upgrading are functioning
correctly. Also, perform a backup of the database and ensure that it completes successfully before
installing the upgraded applications.

• An error message will pop up if there is any database migration error; this will be at a point where
installation can be taken forward without stopping.

During local upgrade, the installer checks to see if Performance Monitor or Resource Manager Essentials is
installed. If one or both of them are found, the installer exits with an error message stating that Performance
Monitor or Resource Manager Essentials (or both) needs to be uninstalled.

Note
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Before creating a backup of a server that is running the Security Manager server application, you must ensure
that all pending data is committed. See Ensuring Security Manager Pending Data is Submitted and Approved
, on page 22.

Note

• Indirect—If you have an older version of the application that is not supported for local upgrade, you
must perform a two-step process. First, you upgrade to a version that is supported for local upgrade, then
you perform the local upgrade. Download the interim version from Cisco.com.

A special note applies to all indirect upgrades with event management enabled (Configuration Manager >
Tools > Security Manager Administration... > Event Management > [Event Management group] > Enable
Event Management. Under these conditions, a detailed view of an event (Launch > Event Viewer > Event
Details > Details) will throw an error. The root cause of this error is restoring an old version of the event
database followed by loading the event data. To work around this problem, identify all of your old partitions
(the ones containing event data generated before your indirect upgrade) and move them to the secondary
partition (“Extended Data Store Location” in the Security Manager GUI at Configuration Manager > Tools
> Security Manager Administration... > Event Management).

Note

If your version is not listed for indirect upgrade in the following table, you need to do three or more interim
upgrade steps if you want to preserve your older data. For example, to upgrade from Security Manager 3.0.x,
you need to upgrade to 3.2.2, and then follow the indirect upgrade path to upgrade from 3.2.2 to 4.28.

Table 1: Application Upgrade Paths explains the software versions that are supported for each upgrade path.

The following upgrade paths are supported:

• 4.27 (including any service pack) > 4.28

• 4.26 (including any service pack) > 4.28

If you are upgrading from any version lower than 4.26, you must first upgrade
to 4.26 before upgrading to 4.28. Local upgrade (Inline upgrade) to CSM 4.28
and 4.27 is only supported from 4.26. For more information about upgrading to
4.26 from any other version, see CSM 4.26 Installation Guide.

Note
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Table 1: Application Upgrade Paths

Upgrade ProcedureSupported
Older
Versions

ApplicationsUpgrade
Path

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Then, install the software; see Installing Security Manager Server and Common Services,
on page 3

3. Finally, make any required post-upgrade changes; see Making Required Changes After
Upgrade , on page 28.

4.27Security
Manager 4.28

Local
(Inline)

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Then, install the software; see Installing Security Manager Server and Common Services,
on page 3

3. Finally, make any required post-upgrade changes; see Making Required Changes After
Upgrade , on page 28.

4.26Security
Manager 4.28

Local
(Inline)

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Back up the database; see Backing Up the Database for Remote Upgrades , on page 25.

3. Install the application, see:

Installing Security Manager Server and Common Services, on page 3

1. If necessary, transfer the database backup to the server.

2. Recover the database; see Restoring the Server Database , on page 27.

3. Finally, make any required post-upgrade changes; see Making Required Changes After
Upgrade , on page 28.

4.27Security
Manager 4.28

Remote

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Back up the database; see Backing Up the Database for Remote Upgrades , on page 25.

3. Install the application, see:

Installing Security Manager Server and Common Services, on page 3

1. If necessary, transfer the database backup to the server.

2. Recover the database; see Restoring the Server Database , on page 27.

3. Finally, make any required post-upgrade changes; see Making Required Changes After
Upgrade , on page 28.

4.26Security
Manager 4.28

Remote
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Upgrade ProcedureSupported
Older
Versions

ApplicationsUpgrade
Path

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

3. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.25Security
Manager 4.28

Indirect

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

3. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

4. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.24Security
Manager 4.28

Indirect

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

3. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

4. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.23Security
Manager 4.28

Indirect

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

3. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

4. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

5. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.22Security
Manager 4.28

Indirect

Installing and Upgrading Server Applications
9

Installing and Upgrading Server Applications
Upgrading Server Applications

https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/424/Installation/b_installation_guide_for_cisco_security_manager_424.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html


Upgrade ProcedureSupported
Older
Versions

ApplicationsUpgrade
Path

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

3. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

4. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

5. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.21Security
Manager 4.28

Indirect

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

3. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

4. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

5. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

6. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.20Security
Manager 4.28

Indirect

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.21 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.21.

3. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

4. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

5. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

6. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.19Security
Manager 4.28

Indirect
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Upgrade ProcedureSupported
Older
Versions

ApplicationsUpgrade
Path

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.20 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.20.

3. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

4. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

5. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

6. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

7. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.18Security
Manager 4.28

Indirect

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.21 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.21.

3. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

4. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

5. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

6. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.17Security
Manager 4.28

Indirect
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
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1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.18, being careful to follow the data migration instructions in the installation
guide’s chapter in upgrade for 4.18.

3. Next, upgrade to 4.20 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.20.

4. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

5. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

6. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

7. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

8. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.16Security
Manager 4.28

Indirect

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.17, being careful to follow the data migration instructions in the installation
guide’s chapter in upgrade for 4.17.

3. Next, upgrade to 4.19 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.19.

4. Next, upgrade to 4.21 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.21.

5. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

6. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

7. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

8. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/418/installation/guide/IG.html
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
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1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.16, being careful to follow the data migration instructions in the installation
guide’s chapter in upgrade for 4.16.

3. Next, upgrade to 4.18 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.18.

4. Next, upgrade to 4.20 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.20.

5. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

6. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

7. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

8. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

9. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.

4.14Security
Manager 4.28

Indirect

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and
Approved , on page 22.

2. Next, upgrade to 4.15, being careful to follow the data migration instructions in the installation
guide’s chapter in upgrade for 4.15.

3. Next, upgrade to 4.17 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.17.

4. Next, upgrade to 4.19 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.19.

5. Next, upgrade to 4.21 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.21.

6. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

7. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

8. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

9. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.28.
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/416/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/418/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/420/installation/guide/IG.html
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/415/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/417/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/419/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/421/installation/guide/IG/inserver.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/423/installation/b_installation_guide_for_cisco_security_manager_423.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
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1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.14, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.14.

3. Next, upgrade to 4.16, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.16.

4. Next, upgrade to 4.18 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.18.

5. Next, upgrade to 4.20 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.20.

6. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

7. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

8. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

9. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

10. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.

4.12Security
Manager 4.28
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/414/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/416/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/418/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/420/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/422/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/424/Installation/b_installation_guide_for_cisco_security_manager_424.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
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1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.13, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.13.

3. Next, upgrade to 4.15, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.15.

4. Next, upgrade to 4.17, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.17.

5. Next, upgrade to 4.19 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.19.

6. Next, upgrade to 4.21 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.21.

7. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

8. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

9. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

10. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/413/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/415/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/417/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/419/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/421/installation/guide/IG/inserver.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/423/installation/b_installation_guide_for_cisco_security_manager_423.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
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1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.12, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.12.

3. Next, upgrade to 4.14, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.14.

4. Next, upgrade to 4.16, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.16.

5. Next, upgrade to 4.18 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.18.

6. Next, upgrade to 4.20 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.20.

7. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

8. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

9. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

10. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

11. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/412/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/414/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/416/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/418/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/420/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/422/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/424/Installation/b_installation_guide_for_cisco_security_manager_424.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
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1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.11, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.11.

3. Next, upgrade to 4.13, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.13.

4. Next, upgrade to 4.15, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.15.

5. Next, upgrade to 4.17, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.17.

6. Next, upgrade to 4.19 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.19.

7. Next, upgrade to 4.21 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.21.

8. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

9. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

10. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

11. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/411/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/413/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/415/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/417/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/419/installation/guide/IG.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/421/installation/guide/IG/inserver.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/423/installation/b_installation_guide_for_cisco_security_manager_423.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/425/Installation/installation_guide_for_cisco_security_manager_425.html
https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html


Upgrade ProcedureSupported
Older
Versions

ApplicationsUpgrade
Path

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.10, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.10.

3. Next, upgrade to 4.12, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.12.

4. Next, upgrade to 4.14, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.14.

5. Next, upgrade to 4.16, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.16.

6. Next, upgrade to 4.18 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.18.

7. Next, upgrade to 4.20 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.20.

8. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

9. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

10. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

11. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

12. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/410/installation/guide/IG.html
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https://www.cisco.com/c/en/us/td/docs/security/security_management/cisco_security_manager/security_manager/426/Installation/installation_guide_for_cisco_security_manager_426.html
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1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.9, being careful to follow the data migration instructions in the
installation guide’s chapter on upgrade for 4.9.

3. Next, upgrade to 4.11, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.11.

4. Next, upgrade to 4.13, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.13.

5. Next, upgrade to 4.15, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.15.

6. Next, upgrade to 4.17, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.17.

7. Next, upgrade to 4.19 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.19.

8. Next, upgrade to 4.21 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.21.

9. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

10. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

11. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

12. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.
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Versions

ApplicationsUpgrade
Path

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.8, being careful to follow the data migration instructions in the
installation guide’s chapter on upgrade for 4.8.

3. Next, upgrade to 4.10, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.10.

4. Next, upgrade to 4.12, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.12.

5. Next, upgrade to 4.14, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.14.

6. Next, upgrade to 4.16, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.16.

7. Next, upgrade to 4.18 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.18.

8. Next, upgrade to 4.20 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.20.

9. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

10. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

11. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

12. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

13. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

14. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

15. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.

4.6Security
Manager 4.28

Indirect
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ApplicationsUpgrade
Path

1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.7, being careful to follow the data migration instructions in the
installation guide’s chapter on upgrade for 4.7.

3. Next, upgrade to 4.9, being careful to follow the data migration instructions in the
installation guide’s chapter on upgrade for 4.9.

4. Next, upgrade to 4.11, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.11.

5. Next, upgrade to 4.13, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.13.

6. Next, upgrade to 4.15, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.15.

7. Next, upgrade to 4.17, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.17.

8. Next, upgrade to 4.19 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.19.

9. Next, upgrade to 4.21 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.21.

10. Next, upgrade to 4.23 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.23.

11. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

12. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

13. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.

4.5Security
Manager 4.28

Indirect
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1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted
and Approved , on page 22.

2. Next, upgrade to 4.6, being careful to follow the data migration instructions in the
installation guide’s chapter on upgrade for 4.6.

3. Next, upgrade to 4.8, being careful to follow the data migration instructions in the
installation guide’s chapter on upgrade for 4.8.

4. Next, upgrade to 4.10, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.10.

5. Next, upgrade to 4.12, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.12.

6. Next, upgrade to 4.14, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.14.

7. Next, upgrade to 4.16, being careful to follow the data migration instructions in the
installation guide’s chapter in upgrade for 4.16.

8. Next, upgrade to 4.18 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.18.

9. Next, upgrade to 4.20 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.20.

10. Next, upgrade to 4.22 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.22.

11. Next, upgrade to 4.24 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.24.

12. Next, upgrade to 4.25 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.25.

13. Next, upgrade to 4.26 and carefully follow the data migration instructions in this installation
guide’s chapter on upgrade for 4.26.

14. Finally, upgrade to 4.28 and carefully follow the data migration instructions in this
installation guide’s chapter on upgrade for 4.28.

4.4Security
Manager 4.28

Indirect

Ensuring Security Manager Pending Data is Submitted and Approved
Before you can successfully upgrade Security Manager, you must ensure that the existing Security Manager
database does not contain any pending data, which is data that has not been committed to the database. You
cannot restore a database from an earlier version of Security Manager if it has pending data; you can only
restore a database that has pending data on a system running the same version as the backup.
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Each user must submit or discard changes. If you are usingWorkflowmodewith an approver, these submissions
must also be approved. You might want to also perform a deployment after all data is committed so that all
device configurations are synchronized with the Security Manager database.

• In non-Workflow mode:

• To commit changes, select File > Submit.

• To discard uncommitted changes, select File > Discard.

• If you need to commit or discard changes for another user, you can take over that user’s session.
To take over a session, select Tools > Security Manager Administration > Take Over User
Session, select the session, then click Take Over Session.

• In Workflow mode:

• To commit and approve changes, select Tools > Activity Manager. From the Activity Manager
window, select an activity and click Approve. If you are using an activity approver, click Submit
and have the approver approve the activity.

• To discard uncommitted changes, select Tools > Activity Manager. From the Activity Manager
window, select the activity, then click Discard. Only an activity in the Edit or Edit Open state can
be discarded.

Restoring Changes that You Made to Property Files
All Security Manager installations have some property files that contain data that you usually change during
use:

• $NMSROOT \MDC\athena\config\csm.properties

• $NMSROOT \MDC\athena\config\DCS.properties

• $NMSROOT \MDC\athena\config\taskmgr.prop

$NMSROOT is the full pathname of the Common Services installation directory [the default is C:\Program
Files (x86)\CSCOpx].

Tip

If you run an upgrade or install a service pack on your current installation, SecurityManager does the following:

• Installs new files in association with the upgrade or service pack.

• Compares the new files with the files that you modified during use.

• Warns you if the new files are different from the files that you changed during use. If they are, Security
Manager does the following:

• Stores the files that you changed during use, naming them <filename>.org .

• Stores diff files for your convenience, naming them <filename>.diff .
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If you receive a warning about new files being different from the files that you modified during use, use the
information in <filename>.org and <filename>.diff to restore the changes that you made to property files
before upgrade or service pack installation.

Editing the csm.properties File After a Remote Upgrade
After a remote upgrade, you must edit the csm.properties file to include newly added properties. Follow these
steps:

Step 1 From $NMSROOT \MDC\athena\config\ subdirectory, open csm.properties in a text editor, such as Notepad.

($NMSROOT is the full pathname of the Common Services installation directory [the default is C:\Program Files
(x86)\CSCOpx])

Step 2 Add the following content to the end of the csm.properties file.

##

# Customize Activity Report Generation

##

# Report generation timeout in minutes

# Set to 10 minutes by default

#generate_activity_report_timeout=10

# Generate PDF Report

#generate_activity_pdf_report=true

# Generate HTML Report

#generate_activity_html_report=false

#CSCup28957::This will allow user to exclude the list of operation rows in all applicable policies from activity change
report.

#excluded operations should be in comma separated and if it is empty or commented then it will include all operations.

#excluded operations::Add,Delete,Modify,Move,ReOrder,Assign,UnAssign. These names should not be modified.

#By default it is empty,if we need to exclude operation then add required excluded operation.

#ex: 1.ActChangeReport.excludedOperations=ReOrder, 2.ActChangeReport.excludedOperations=Add,ReOrder ,
3.ActChangeReport.excludedOperations=Add,Modify,Move,ReOrder

ActChangeReport.excludedOperations=

The above lines of code are commented by default. If you want to use the default values or modify the values of a particular
property in the file, you must first uncomment the given line of code. For example, if you want Security Manager to
generate Activity Reports in PDF format, you must change the given property as follows:

# Generate PDF Report

generate_activity_pdf_report=true

Step 3 Save, and then close, the edited file.
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Step 4 Restart the Cisco Security Manager Daemon Manager service from Start > Programs > Administrative Tools >
Services.

Backing Up the Database for Remote Upgrades
CiscoWorks Common Services manages the database for all server applications, and it is the Common Services
backup/restore utilities that are used for backing up and restoring the database. Thus, when you create a
backup, you are creating a backup for all CiscoWorks applications installed on the server.

Beginning with Security Manager 4.4, a new attribute, PURGE_DBBACKUP_LOG, has been added to the
backup.properties file; it has a default value of 20, meaning that backups will be purged after 20 days. If this
new attribute is set to NIL, then backups will not be purged. The dbbackup.log is created with a timestamp
format of dbbackup_[YYYY-MM-DD_HH-mm-ss].log. At any point of time, a minimum of 5 dbbackup.log
files will be maintained irrespective of purge configuration.

Note

To back up the database, the Short Date format should be either M/d/YYYY or M/d/yy. To change the Short
Date format to either M/d/YYYY or M/d/yy, select Start > Control Panel > Region and Language > Formats
> Short Date, and then change the Short Date format to either M/d/YYYY or M/d/yy.

Note

The backup procedure backs up the database only. If you need to back up the event data store, use the data
store copy steps described in Migrating Security Manager to a New Computer or Operating System, on page
29.

Tip

Step 1 If you are backing up a server that is running Security Manager, you can get to the backup page using a shortcut in the
Security Manager client: Tools > Backup. Also, ensure that pending data is committed (see Ensuring Security Manager
Pending Data is Submitted and Approved , on page 22).

For servers that are not running Security Manager, to get to the backup page:

a) Log in to the Cisco Security Management Server desktop on the server (see Logging In to Server Applications Using
a Web Browser).

b) Click the Server Administration panel. Then select Server > Admin > Backup.

Step 2 Select Immediate for Frequency, complete the other fields as desired, and click Apply to back up your data.

Backing Up the Server Database By Using the CLI
The procedure in this section describes how to back up the server database by executing a script from the
Windows command line on the server.
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While backing up the database, both Common Services and Security Manager processes will be shut down
and restarted. Because Security Manager can take several minutes to fully restart, users might be able to start
their client before the restart is complete. If this happens, they might see the message “error loading page” in
device policy windows.

A single backup script is used to back up all applications installed on a CiscoWorks server; you cannot back
up individual applications.

The backup command backs up the database only. If you need to back up the event data store, use the data
store copy steps described in Migrating Security Manager to a New Computer or Operating System, on page
29.

Tip

Step 1 Ensure that pending data is committed (see Ensuring Security Manager Pending Data is Submitted and Approved , on
page 22).

Step 2 At a command prompt, enter net stop crmdmgtd to stop all processes.
Step 3 Back up the database by entering the following command:

$NMSROOT\bin\perl $NMSROOT\bin\backup.pl backup_directory [log_filename [email=email_address
[number_of_generations [compress]]]]

where:

• $NMSROOT—The full pathname of the Common Services installation directory [the default is C:\Program Files
(x86)\CSCOpx].

• backup_directory —The directory where you want to create the backup. For example, C:\Backups.

The location that you select to use for the backup must be outside NMSROOT . The location NMSROOT is
the path to the Security Manager installation directory. The default is C:\Program Files (x86)\CSCOpx. In
particular, note that NMSROOT \backup must not be used for the backup.

Note

The backup directory should not contain any special characters.Note

• log_filename—(Optional) The log file for messages generated during backup. Include the path if you want it created
somewhere other than the current directory. For example, C:\BackupLogs. If you do not specify a name, the log is
$NMSROOT \log\dbbackup.log.

• email=email_address —(Optional) The email address where you want notifications sent. If you do not want to
specify an email address, but you need to specify a subsequent parameter, enter email without the equal size or
address. You must configure SMTP settings in CiscoWorks Common Services to enable notifications.

• number_of_generations —(Optional) The maximum number of backup generations to keep in the backup directory.
When the maximum is reached, old backups are deleted. The default is 0, which does not limit the number of
generations kept.

• compress—(Optional) Whether you want the backup file to be compressed. If you do not enter this keyword, the
backup is not compressed if VMS_FILEBACKUP_COMPRESS=NO is specified in the backup.properties file.
Otherwise, the backup is still compressed. We recommend compressing backups.

For example, the command shown below assumes that you are in the directory containing the perl and backup.pl commands.
(When you are in that directory, though, you must still specify the entire path of perl and backup.pl, fully qualified in the
DOS 8.1 format with no spaces.)
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The command shown below creates a compressed backup and log file in the backups directory and sends notifications
to admin@domain.com.

When you use the backup.pl command, you must specify a backup generation if you want to include the compress
parameter.

If you specify any parameter after the log file parameter, you must include values for all preceding parameters.

In this example, $NMSROOT is D:\CSM, not the default value of C:\Program Files (x86)\CSCOpx.

D:\CSM\bin\perl D:\CSM\bin\backup.pl C:\backups C:\backups\backup.log email=admin@domain.com 0 compress

Step 4 Examine the log file to verify that the database was backed up.

If Security Manager restarts unexpectedly during the database backup process, the backup is interrupted and
a backup lock file backup.lock is created in the NMSROOT directory. Delete the backup.lock file to proceed
with backup.

Note

Step 5 At a command prompt, enter net start crmdmgtd to restart all processes.

Restoring the Server Database
You can restore your database by running a script from the command line. You have to shut down and restart
CiscoWorks while restoring data. This procedure describes how you can restore the backed up database on
your server. A single backup and restore facility exists to back up and restore all applications installed on a
CiscoWorks server; you cannot back up or restore individual applications.

If you install the applications on multiple servers, ensure that you recover the database backup that contains
data appropriate for the installed applications.

Tips

• You can restore backups taken from previous releases of the application if the backup is from a version
supported for direct local inline upgrade to this version of the application. For information on which
versions are supported for upgrade, see Upgrading Server Applications , on page 6.

• The restore command restores the database only. If you need to restore the event data store, use the data
store copy steps described in Migrating Security Manager to a New Computer or Operating System, on
page 29.

Procedure

Step 1 Stop all processes by entering the following at the command line:

net stop crmdmgtd

Step 2 Restore the database by entering the following command:

$NMSROOT\bin\perl $NMSROOT\bin\restorebackup.pl [-t temporary_directory ][-gen generationNumber ] -d
backup_directory [-h help] [-m Email]

where:

• $NMSROOT—The full pathname of the Common Services installation directory [the default is C:\Program Files
(x86)\CSCOpx].
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• -t temporary_directory—(Optional) This is the directory or folder used by the restore program to store its temporary
files. By default this directory is $NMSROOT \tempBackupData.

• -gen generationNumber —(Optional) The backup generation number you want to recover. By default, it is the latest
generation. If generations 1 through 5 exist, 5 will be the latest.

• -d backup_directory —The backup directory that contains the backup to restore.

• -h—(Optional) Provides help. When used with -d BackupDirectory , help shows the correct syntax along with
available suites and generations.

• -m—Use to send email on the restore status as Success or Failure.

For example, to restore the most recent version from the c:\var\backup directory, enter the following command (note that
this is for a 64-bit OS):

C:\Progra~2\CSCOpx\bin\perl C:\Progra~2\CSCOpx\bin\restorebackup.pl -d C:\var\backup

Step 3 Examine the log file, NMSROOT\log\restorebackup.log, to verify that the database was restored.
Step 4 Restart the system by entering:

net start crmdmgtd

Step 5 If you restore a database that was backed up prior to installing a Security Manager service pack, you must reapply the
service pack after restoring the database.

Making Required Changes After Upgrade
Sometimes an application upgrade changes how particular types of information are handled in Cisco Security
Manager. You are therefore required to make some manual changes. After upgrading to this version of the
product, consider the following list of required changes and perform any that apply to your situation:

Additionally, refer to the Important Notes section of the release notes for this release for other considerations
that might apply to your installation of Security Manager after an upgrade.

Note

• If you upgrade from any version earlier than 3.3.1, you must rediscover the inventory on any ASA 5580
device that includes a 4-port GigabitEthernet Fiber interface card (hardware type: i82571EB 4F). Inventory
rediscovery overcomes a bug from previous releases that prevented changing speed nonnegotiate settings
on the device. To rediscover inventory, right-click the device in Device view in the Security Manager
client and selectDiscover Policies on Device, then select Live Device discovery and only the Inventory
check box in the Policies to Discover group. Rediscovery replaces the Interfaces policy on the device.

• If you upgrade from 3.3.1 or lower versions, and you managed Cisco ASR 1000 Series Aggregation
Services Routers that used unsupported shared port adapters (SPA), you must rediscover policies on
those devices so that Security Manager can discover the SPAs that were supported starting with version
4.0. Newly supported SPAs include all Ethernet (all speeds), Serial, ATM, and Packet over Sonet (POS)
shared port adapters (SPA), but not services SPAs. Rediscovery is required if you configured ATM,
PVC, or dialer related policies in the device CLI.
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Migrating Security Manager to a New Computer or Operating
System

Customers upgrading their Operating System while migrating to Cisco Security Manager 4.9 or later, must
buy the appropriate Windows license.

Note

Certain circumstances might require you to move Security Manager to a new server. This move might be to
a new physical machine, or you might want to perform a major upgrade to the operating system on the server
(such as moving fromMicrosoftWindows Server 2008 R2with SP1 Enterprise—64-bit toMicrosoftWindows
Server 2016 Standard—64-bit or to Microsoft Windows Server 2016 Datacenter—64-bit).

When you are not changing the Security Manager version, but you are changing the physical hardware or the
operating system, you need to go through a migration process. The migration process is essentially the same
as the remote backup/restore upgrade process as described in Upgrading Server Applications , on page 6;
however, additional steps are required to migrate the data contained in the Event Manager data store. Use this
procedure when you need to perform Security Manager server migration.

Minor service pack updates to an operating system are not considered upgrades when it comes to Security
Manager server-migration requirements. Server migration is required when you are moving between different
major versions of the operating system.

Note

Before You Begin

This procedure assumes that you want the target server (the server to which you are moving SecurityManager)
to have the same database and event data store contents as the source computer. If you started using Security
Manager on the target server, you cannot merge the database or event data store of the source and target
systems: you must replace the target data with the source data. Any data that existed on the target system prior
to the migration will become unusable after completing the migration. Do not attempt to copy the old
target-system data into the newly-migrated folder.

Also note that the steps for copying and restoring the event data store are required only if you want to preserve
this data. You can skip the steps if you want to start with a fresh empty event data store.

Step 1 Do the following on the source Security Manager server (the server from which you are migrating):
a) Determine the name of the event data store folder. Using the Security Manager client, select Tools > Security

Manager Administration, and select Event Management from the table of contents. The folder is shown in the
Event Data Store Location field; the default is NMSROOT\MDC\eventing\database, where NMSROOT is the
installation directory [usually C:\Program Files (x86)\CSCOpx].

b) Stop all processes by entering the following at the command line:

net stop crmdmgtd

c) Make a copy of theNMSROOT\MDC\eventing\config\collector.properties file and the event data store folder. Place
the copy on a disk where you can access it from the target computer.
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d) Back up the Security Manager database using the command line method as described in Backing Up the Server
Database By Using the CLI , on page 25.

Step 2 Prepare the new target computer. For example:

• If you are simply upgrading the operating system, but not moving to new hardware, perform the operating system
upgrade and ensure that the operating system is functioning correctly. Then, install Security Manager.

• If you are moving to a new computer, ensure that it is functioning correctly and install Security Manager.

Step 3 Do the following on the target Security Manager server:
a) Stop all processes by entering the following at the command line:

net stop crmdmgtd

b) Copy the backed up NMSROOT\MDC\eventing\config\collector.properties file from the source computer to the
target server, overwriting the file on the target server.

c) If you did not restart processes after completing the database restore, restart them now:

net start crmdmgtd

d) Use the Security Manager client to log into the new server, then select Tools > Security Manager Administration,
and select Event Management from the table of contents.

e) Ensure that the event data store folder exists and that it is empty (delete files if necessary). The folder must have the
same name and location as the event data store had on the source server.

f) Select the correct Event Data Store Location (if the default is not already the correct folder), and deselect the Enable
Event Management check box to stop the EventManager service. Click Save to save your changes. You are prompted
to verify that you want to stop the service; click Yes, and wait until you are notified that the service has stopped.

g) Copy the event data store backed up from the source computer to the new location on the target server.
h) Using the SecurityManager client, selectTools > Security Manager Administration, and selectEvent Management

from the table of contents. Select the Enable Event Management check box and click Save. You are prompted to
verify that you want to start the service; click Yes, and wait until you are notified that the service has started.

Updating Security Manager
Although you can specify permanent license files during installation, you can also add licenses after you install
Security Manager.

Before You Begin

You must copy the license file to the server machine or to the client machine before adding it (the license) to
the application. If you use the client machine, you must enable the client-side browser.

The path to the license file must not contain special characters such as the ampersand (&).Note
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You can also apply a license while logging into Security Manager: Security Manager will prompt with the
message “Upgrade license” or “Continue Evaluation.” By clicking “Upgrade License,” you can apply the
license.

Tip

Procedure

To install a license for Security Manager, follow these steps:

Step 1 Log in to the server using the SecurityManager client application (see Logging In to SecurityManager Using the Security
Manager Client).

Step 2 Select Tools > Security Manager Administration and select Licensing from the table of contents.
Step 3 Click CSM if the tab is not active.
Step 4 Click Install a License to open the Install a License dialog box. Use this dialog box to select the license file and click

OK. Repeat the process to add additional licenses.

The path and file name are restricted to characters in the English alphabet. Japanese characters are not
supported. When selecting files on a Windows Japanese OS system, the usual file separator character \ is
supported, although you should be aware that it might appear as the Yen symbol (U+00A5).

Note

Obtaining Service Packs and Point Patches

Do not download or open any file that claims to be a service pack or point patch for Security Manager unless
you obtain it from Cisco. Third-party service packs and point patches are not supported.

Caution

After you install Security Manager or other applications, you might install a service pack or point patch from
Cisco Systems to fix bugs, support new device types, or otherwise enhance the application.

• To learn when Cisco has prepared a new service pack, and to download any service pack that matters to
you, open Security Manager, then select Help > Security Manager Online. Alternatively, go
tohttp://www.cisco.com/go/csmanager.

• If your organization submits a Cisco TAC service request, TAC will tell you if an unscheduled point
patch exists that might solve the problem you have described. Cisco does not distribute SecurityManager
point patches in any other way.

Service packs and point patches provide server support for client software updates and detect version level
mismatches between a client and its server.
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Uninstalling Server Applications
Use this procedure to uninstall server applications. Before uninstalling an application, consider performing a
backup so that you can recover your data if you decide to re-install the application. For information on
performing backups, see Backing Up the Database for Remote Upgrades , on page 25.

Before You Begin

If any version ofWindows Defender is installed, disable it before you uninstall a server application. Otherwise,
the uninstallation application cannot run.

Procedure

To uninstall server applications, follow these steps:

Step 1 Select Start > Programs > Cisco Security Manager > Uninstall Cisco Security Manager.

By default, all applications will be uninstalled.

Step 2 The uninstaller removes all applications.

If the uninstallation causes an error, see Server Problems During Installation, and the “Troubleshooting and
FAQs” chapter in Installing and Getting Started With CiscoWorks LAN Management Solution 3.1 :
http://www.cisco.com/en/US/products/sw/cscowork/ps3996/prod_installation_guides_list.html.

Note

Step 3 Although no reboot is required, we recommend that you reboot the server after an uninstallation so that Registry entries
and running processes on the server are in a suitable state for a future re-installation.

Step 4 Perform the following steps only if you uninstall all Cisco Security Management Suite applications, including Common
Services:
a) If NMSROOT still exists, delete it, move it, or rename it. NMSROOT is the path to the Security Manager installation

directory. The default value of NMSROOT is C:\Program Files (x86)\CSCOpx. Other values, such as E:\Program
Files (x86)\CSCOpx, are possible as well.

b) If the C:\CMFLOCK.TXT file exists, delete it.
c) Use a Registry editor to delete these Registry entries before you re-install the applications:

• My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cisco\Resource Manager

• My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cisco\MDC

d) Delete any folders under NMSROOT that were not deleted during uninstallation.

Step 5 If you disabled Windows Defender before uninstalling the applications, re-enable it now.

Downgrading Server Applications
You cannot downgrade Security Manager applications to earlier releases and preserve any configurations that
you created in this release of the product. If you decide that you do not want to use this release of Security
Manager, you can uninstall it and reinstall the desired older version of the product. (This assumes that you
have the required licenses and installation media for the older version.) You can then restore the desired
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database backup that you saved from your previous installation of the downgraded version, as described in
Restoring the Server Database , on page 27.

After you restore the old database, keep in mind that it might contain device properties and policies that are
no longer synchronized with the current state of the managed devices. For example, you might have upgraded
the operating system on the device to one that is not directly supported by the older version of Security
Manager, or you might have configured, and deployed, policies that do not exist in the older version. To
ensure that the database is synchronized with the devices, consider rediscovering device policies for all
managed devices. Be aware that some major changes (such as a major operating system release upgrade)
require that you remove the device from the inventory and add it again. In some cases, you might need to
revert an operating system upgrade (for example, ASA Software release 8.3 requires special handling and
cannot be supported in downward compatibility mode, therefore, the Security Manager version you use must
support it directly). See the “Managing the Device Inventory” chapter in the User Guide for Cisco Security
Manager for more information.

If you try to manage a device and operating system release combination that the older version of Security
Manager cannot manage, you will see deployment errors.

Tip
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